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CHAPTER

1

Introduction
This manual describes how to set up and configure the
Larson Davis NoiseTutor System. The NoiseTutor System is
designed to provide portable and remote observation of
monitoring sites with features for performing the following
functions:

These functions can be
simultaneously, if desired.

used

The NoiseTutor System software
comes pre-installed when NoiseTutor
is purchased as a system.

•

Provide customizable graphs of measurement data files,
including time histories and spectrograms

•

Provide customizable real-time graphical reports of
sound measurements

•

Deliver sound level data files and graphical reports via email

•

Deliver sound level data files and graphical reports to
FTP servers

•

Provide event detection and graphical event notification
through e-mail, text messaging to cell phones, and web
publishing

•

Record audio files of measurements to be sent with
reports

•

Provide simplified and centralized method for specifying
recipients for e-mail and text messaging

•

Provide administrative e-mail and text messaging
support for operating and maintaining the NoiseTutor
System

Setting up the NoiseTutor System includes the following
procedures:
1.
2.
3.
4.
5.
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Checking NoiseTutor Components
Configuring the NoiseTutor server
Setting up the NoiseTutor Station
Installing the NoiseTutor System software, if not
already pre-installed
Connecting peripheral and power devices

Introduction
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Figure 1-1 shows the components and architecture of the
NoiseTutor System.

FIGURE 1-1 Components and Architecture - NoiseTutor System

Checking NoiseTutor Components
The NoiseTutor System is comprised of the following:
1.

2.
3.
1-2

The NoiseTutor Station, including:
• Model 831 sound level meter
• Station PC
• LCD display
• Compact, remote keyboard with trackball
• Preamplifier
• Microphone
• Environmentally-sealed station case
NoiseTutor Server Configuration Software
Web and FTP Server (customer-supplied)
NoiseTutor System Manual

The following table lists the components for the NoiseTutor
Station model EPS041 (NoiseTutor Accessory Kit) and
NMS021 (complete NoiseTutor Kit including Model 831
Sound Level Meter):

System

Component

EPS041

Outdoor enclosure including gland for AC power and mic cable

EPS041

Compact Industrial PC With Windows 7 Pro®

EPS041

LCD Monitor

EPS041

Portable wireless keypad with trackball

EPS041

Cellular modem for cellular network access

EPS041

Lithium battery w/charger

EPS041

Quick Reference Guide, Installation Reference, and NoiseTutor Manual

EPS041

CD with starter software

NMS021

831-FF Type 1 Sound Level Meter

NMS021

PRM831 Preamplifier with 377B02 free-field polarized microphone

NMS021

831-LOG, 831-ELA and 831-OB3 firmware modules

NMS021

EPS2116 Outdoor protection

NMS021

EPS041 NoiseTutor Accessory Kit (see above)

NMS021

EXC020 20 ft. (6m) extension cable

NMS022

PRM2103-FF preamplifier

NMS022

CBL203

The NoiseTutor Installation Reference is located inside your
NoiseTutor station case and describes the assembly and
operation of your station.

NoiseTutor System Manual
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Optional Accessories
The following table lists the optional accessories for the
NoiseTutor Station:

Component

Part number

Instrumentation Tripod

TRP003

Tripod Mounting Adapter

EPS2106-2 to TRP003 (ADP034)

Basic Tripod

TRP001

Outdoor Preamplifier

PRM2103-FF

Weather Station

SEN031

Anemometer

SEN032

GPS

GPS001

Custom Cable Plug

ACC007
If you are using an outdoor preamplifier or a weather station,
you can connect the power for either or both to the
NoiseTutor Station by using connectors inside the case that
are labeled “Accessories.” If using these accessories, you
also need to order the Custom Cable Plug for the extra cable
outlet in your NoiseTutor Station case.

Configuring the NoiseTutor Server
Larson Davis provides server configuration aids with the
NoiseTutor System to provide web access to sound level
monitoring sites. This includes the NoiseTutor Server
Configuration Tool, which can be used with instructions in
this manual to set up a server on a Windows®-based
computer. The server consists of both a website--with a
collection of pre-designed web pages--and an FTP site.
The pre-designed server web pages present information
from each monitoring site in the following forms:
•
1-4

Optional Accessories

Ten-minute report
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•

One-hour report

•

One-day report

•

One-week report

•

One-month report

Although you can use any web site server that is capable of
rendering HTML pages with Java Script, the configuration
aids in this manual describe the steps for using Internet
Information Services (IIS) from Microsoft. This manual
describes configuration with IIS because it is currently the
most common web server for Windows® operating systems
and it is available at no cost.
Although the NoiseTutor system
provides server configuration aids,
you are responsible for setting up the
web server.

You can also set up an FTP site on your server; in this way,
you can collect noise monitoring data from Noise Tutor
clients. This data can then be displayed in graphic reports for
each monitoring site on a web site.
The process of installing and configuring the NoiseTutor
Server involves complex and technical tasks, and generally
requires the services of an IT professional. For your
assistance, detailed instructions for installing and
configuring the NoiseTutor Server on a Windows 7 platform
are provided in this manual.
The NoiseTutor System also functions on Windows XP SP 3
and Windows Vista SP 1. However, the steps and options are
different than those represented in this manual. To install
and configure the NoiseTutor System on these platforms,
Larson Davis recommends that you consult with an IT
professional. Detailed instructions for setting up a server on
other platforms are not available from Larson Davis.

System requirements for NoiseTutor Server
Configuration
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•

A PC system to be used as an FTP server

•

Windows 7 SP 1, Server or Professional editions. Server
edition is recommended.

•

IIS 5.1 or higher

Optional Accessories
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•

One or more NoiseTutor Noise Monitoring Systems
(NMS)

•

Sound level meter serial number for each NoiseTutor
station

Setting up the NoiseTutor Station
The NoiseTutor Quick Start Guide
describes the steps for deploying
your NoiseTutor Station.

To set up your NoiseTutor Station, refer to the NoiseTutor
Quick Start Guide, the NoiseTutor Installation Reference,
and this manual. These are located inside the NoiseTutor
station case.

Installing NoiseTutor Station Software
The NoiseTutor Station software comes pre-installed when
ordering the NMS-021 (with Model 831 sound level
meters), and the EPS 041 (without Model 831 sound level
meters). For other configurations, the software must be
installed on the PC that is connected to the sound level
meter. The software interacts with noise monitoring stations
by downloading measured data from the sound level meters
at predefined intervals. It then sends data or graphical
reports to specified recipients. If your system does not
include pre-installed software, refer to the instructions in
"Station Installation and Setup".

System Requirements for NoiseTutor Station
Software

Larson Davis does not supply an
active SIM card. You must obtain one
separately.

1-6

Optional Accessories

•

Larson Davis sound level meter Model 831

•

Windows 2000® or newer operating system

•

Active SIM card
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2

Server Installation and
Setup
This chapter lists and describes the steps for setting up the
NoiseTutor server on the Windows 7® operating system. To
install the server, complete the following process:
1.
2.
3.
4.
5.
6.
7.

Install IIS on Windows 7.
Configure the IIS web server.
Add Audio MIME Types.
Install the NoiseTutor Server Configuration Tool.
Run the NoiseTutor Server Configuration Tool.
Create an FTP user account.
Configure the Windows Firewall.

Each step is described in more detail in the following
sections.
Before You Begin: The process of installing and configuring the NoiseTutor Server involves complex and technical
tasks, and generally requires the services of an IT professional. These detailed instructions are provided for the convenience of an IT professional working with your NoiseTutor
System.

Installing IIS on Windows 7 Operating System
The NoiseTutor System also functions on Windows XP® SP
3 and Windows Vista® SP 1. However, the steps and options
are different than those represented in this manual. To install
and configure the NoiseTutor System on these platforms,
Larson Davis recommends that you consult with an IT
professional. Detailed instructions for setting up a server on
other platforms are not available from Larson Davis.
Installing the IIS add-in provides your host PC with both
web- and FTP-server functionality. If you do not want to use
IIS, you will need to supply your own web server and FTP
server. To install IIS, follow these steps:
NoiseTutor System Manual
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If the Programs and Features icon
is not displayed in your Control
Panel, click the drop down arrow in
the address bar following the words
“Control Panel.” Click All Control
Panel Items. The Programs and
Features icon should then appear
with other icons in your Control
Panel.

Step 1
Panel.

On the Windows 7® Start menu, click Control

Step 2

Click Programs and Features.

Step 3 On the left window border, click Turn Windows
features on or off, as shown in FIGURE 2-1.

FIGURE 2-1 Turn Windows® Features On or Off
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Step 4

Select Internet Information Services.

Step 5

Expand Internet Information Services.
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Step 6 Expand FTP Server. Select all items, as shown in
FIGURE 2-2.
Step 7 Select Web Management Tools, as shown in
FIGURE 2-2. Accept all defaults.
Step 8 Select World Wide Web Services, as shown in
FIGURE 2-2. Accept all defaults.

FIGURE 2-2 Windows® Features - Internet Information Services
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Step 9 Click OK.Wait for Windows to make changes, as
shown in FIGURE 2-3.

FIGURE 2-3 Microsoft Windows® - Please Wait
Step 10 Close Programs and Features.

Configuring the IIS Web Server
You can configure the IIS web server to set up your
NoiseTutor web site. The following configuration places the
web pages for your site in a virtual directory and sets the
FTP server upload location as a subdirectory of that virtual
directory. To set up your web site, follow these steps:
Step 1 Browse to c:\inetpub\wwwroot\ and click the
New Folder button and name it LarsonDavis.
Step 2 Open inetmgr at the following location:
c:\windows\system32\inetsrv\inetmgr.exe.

2-4

Step 3

Expand the name of your computer.

Step 4

Expand Sites.
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Step 5 Depending on your operating system, you may
have the option of creating a new web site. Otherwise, you
may be provided only with the default web site option, as
shown in FIGURE 2-4.

FIGURE 2-4 IIS Manager - Expand Sites
Step 6
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Select Default Web Site.
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Step 7 Select View Virtual Directories, as shown in
FIGURE 2-5.

FIGURE 2-5 IIS Manager - View Virtual Directories
Step 8 Click Add Virtual Directory, as shown in
FIGURE 2-6.

FIGURE 2-6 IIS Services Manager - Add Virtual Directory
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Step 9 In the Add Virtual Directory dialog box, type
LarsonDavis in the Alias field, as shown in FIGURE 2-7.
Larson Davis strongly recommends
that you specify, select, or accept all
defaults for your configuration, as
shown in this manual.

Step 10 For Physical path, specify LarsonDavis as the
default root directory by typing the path as shown in
FIGURE 2-7.
Step 11 Click the Connect as…, as shown in FIGURE 27.

FIGURE 2-7 Add Virtual Directory - Connect As
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Step 12 In the Connect As dialog box, select the
Application user (pass-through authentication) option
and click OK, as shown in FIGURE 2-8.

FIGURE 2-8 Connect As - Application User (pass through authentication)
Application user settings should not
include errors, but can include
warnings about being unable to
verify access to the virtual directory.
Such warnings are permissible
because the user names and
passwords are not available until the
user accesses the web site.

Step 13 Select the application path and click Edit
Permissions..., as shown in FIGURE 2-9.

FIGURE 2-9 IIS Manager - Edit Permissions
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Step 14 On the LarsonDavis Properties sheet, click the
Security tab, as shown in FIGURE 2-10.
Step 15 Select the user or group that will access the web
site, as shown in FIGURE 2-10. Ensure the user or group has
the following permissions:
A. Read & execute
B. List folder contents
C. Read
It is recommended that you not grant other permissions.
Step 16 Click Apply if you have made changes.
Otherwise, click OK.

FIGURE 2-10 Larson Davis Properties - Security
Step 17 Expand Default Web Site and double-click
LarsonDavis.
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Step 18 Double-click Default Document, as shown in
FIGURE 2-11.

FIGURE 2-11 IIS Manager - Default Document
Step 19 Remove all default documents except for
index.html.
Step 20 If index.html is not present, click Add and in the
Add Default Document dialog box, type index.html and
then click OK, as shown in FIGURE 2-12.

FIGURE 2-12 Add Default Document
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Adding Audio MIME Types
If your NoiseTutor Station includes options for events and
audio recording, with license files SWW-DNA-NT-EV and
SWW-DNA-NT-CS, respectively, your web server must be
configured for playing .ogg audio files. This is done by
configuring MIME. If these options have not been
purchased, this step can be skipped.
To add audio MIME types for supporting the audio
recording feature, follow these steps:
Step 1 In the IIS Manager, double-click MIME Types, as
shown in Figure 2-13.

FIGURE 2-13 IIS MIME Types
Step 2 In the MIME Types list, click Add, as shown in
Figure 2-14.

NoiseTutor System Manual
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FIGURE 2-14 Add MIME Types
Step 3 In the Add MIME Type dialog box, type .ogg for
the File name extension and type audio/ogg for MIME
type, as shown in Figure 2-15.

FIGURE 2-15 Add MIME Type ogg
Step 4

Click OK.

Step 5 As shown previously, in the MIME Types list,
click Add.
Step 6 In the Add MIME Type dialog box, type .ogx for
the File name extension and type audio/ogx for MIME
type, as shown in Figure 2-16.

2-12
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FIGURE 2-16 Add MIME Type ogx
Step 7

Click OK.

Installing the NoiseTutor Server Configuration
Tool
To install the NoiseTutor Configuration Tool, follow these
steps:
Step 1

Insert NoiseTutor CD into your CD/DVD drive.

Step 2 If auto start is not enabled, Click [CD /
DVD]\NoiseTutorConfigurationInstaller.exe.
Step 3 On the NoiseTutor Configuration Tool Setup
Wizard, Click Next, as shown in FIGURE 2-17.

NoiseTutor System Manual
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FIGURE 2-17 Configuration Tool Installer - Welcome
Step 4 Select the folder where you want to install the
NoiseTutor Configuration Tool, as shown in FIGURE 2-18.
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Step 5

Select either Everyone or Just me.

Step 6

Click Next to install the default installation folder.

NoiseTutor System Manual

FIGURE 2-18 Configuration Tool Installer - Select Installation Folder
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Step 7 To confirm the installation, click Next again. The
wizard displays the installation progress as shown in
FIGURE 2-19.

FIGURE 2-19 Configuration Tool - Installing NoiseTutor Configuration Tool
Step 8

Click Close.

Running the NoiseTutor Configuration Tool
The NoiseTutor Configuration Tool can be used to set up the
following functionality on the server:

2-16

•

Generate web pages

•

Request specific monitoring site information to populate
web page templates

•

Generate and send graphical reports to a specified
location

•

Create an FTP directory for uploading site information

NoiseTutor System Manual

You are responsible for assigning
users and giving them the correct
permissions to any FTP upload
directories you create with the
NoiseTutor Configuration Tool.

To run the NoiseTutor Configuration Tool, follow these
steps:
Step 1 On the Start menu, click Computer. Browse to
the NoiseTutor.exe file in the NoiseTutor folder, and
double-click it.
Step 2 If you are configuring a new site, click New
Configuration on the File menu of the NoiseTutor Site
Configuration Tool dialog box.
Step 3 If you are modifying an existing configuration,
click Open Configuration on the File menu.
Step 4 From the Open dialog box, browse to the location
of your existing site configuration file (.csf) and doubleclick it.
Step 5 For Monitoring Site information, provide decimal
values for the Latitude and Longitude coordinates of your
site, as shown in FIGURE 2-20. Refer to Google Maps, or
another map service for help in finding these values for your
site.

FIGURE 2-20 Configuration Tool - Information Launch3
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Step 6 For Zoom, type a numeric value for the zoom
level of the Google map to display for your site. The number
you specify corresponds to the Google Maps designation of
zoom levels, where zero (0) displays a map of the world and
21displays an individual building. Larson Davis provides a
default value of 12.
Step 7 For Sound Level Meter, specify the Type as model
831 or LxT.
Step 8 For Serial Number, specify your sound level
meter serial number. You can find the serial number by
turning on your meter with the 0 (ON/OFF) button,
pushing the 3 (TOOLS) key, scrolling to the About folder,
selecting the folder by pressing 1 (ENTER), and retrieving
the number displayed in the Instrument Information section.
Step 9 Provide the appropriate information for the
remaining fields in this dialog box.
Step 10 Repeat steps one through six for each site, as
needed.
Step 11 On the File menu, click Save Configuration.
Step 12 On the Generate Sites menu, click No Events if
your system does not include Event Detection as a feature.
Event Detection is an optional feature that requires a
purchased license file to operate. If you have purchased the
license file, click With Events. This step creates the web
files for the configuration.
Step 13 In Browse for Folder, click the folder location
that you specified for your virtual directory.
Step 14 For Confirm Delete, click Yes to delete current
web files. All previous files in the virtual directory are
deleted prior to regenerating the new files. Click No to leave
all previous files during generation. Duplicate files are
overwritten.
Step 15 For Successful Generation, click OK.
Step 16 To close NoiseTutor Site Configuration Tool, click
Exit on the File menu.
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Creating User Accounts for FTP Uploads
You can create user accounts for your FTP client to
authenticate itself with an FTP server. User accounts should
have write access permissions to the FTP server
UploadImages folder, and any sub-folders, but any
additional rights are best left restricted. To create a user
account, follow these steps:

If Administrative Tools is not
displayed in your Control Panel,
click the drop down arrow in the
address bar following the words
“Control Panel.” Click All Control
Panel Items. The Administrative
Tools icon should appear with other
icons in your Control Panel.

Step 1

On the Start menu, click Control Panel.

Step 2

Click Administrative Tools.

Step 3

Double-click Computer Management.

Step 4

Expand Local Users and Groups.

Step 5

Click the Users folder, as shown in FIGURE 2-21.

FIGURE 2-21 Computer Management - Users
Step 6
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On the Action menu, click New User.
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Larson Davis strongly recommends
that you specify, select, or accept all
defaults for your configuration, as
demonstrated in this manual.

Step 7 In the New User dialog box, provide the user
name, full name, description; also, create a password as
shown in FIGURE 2-22. The default name for user accounts
is UploadUser. Do not select any additional options on this
dialog box.
Step 8

Click Create.

\

FIGURE 2-22 New User - Create
Step 9

2-20

Click Close.
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Step 10 Click the name of the user account, or the default
name UploadUser, if applicable, as shown in FIGURE 2-23.

FIGURE 2-23 Computer Management - Upload User
Step 11 Provide the user account with the appropriate
permissions to the FTP upload folder UploadImages and its
sub-folders. This folder is a sub-folder in your NoiseTutor
virtual directory. Permission options may vary but should
include write access. It is best to restrict permissions to only
the UploadImages folder and any sub-folders.
Step 12 On the Actions menu, click Properties.
Step 13 Click the Member Of tab.

NoiseTutor System Manual
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Step 14 On the Properties dialog box, select any entries
listed under Member of: and click Remove, as shown in
FIGURE 2-24.

FIGURE 2-24 UploadUser Properties - Member of
Step 15 Click Apply.
Step 16 Click OK.
Step 17 To close the Computer Management screen click
Exit on the File menu.
Step 18 Close the Administrative Tools screen and the
Control Panel.
Step 19 From the Start menu, click Computer.
Step 20 Browse to the default virtual directory at
c:\inetpub\wwwroot\LarsonDavis\UploadImages, as
specified in Step 7.
Step 21 Right-click UploadImages and select Properties.
2-22
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Step 22 On the Properties dialog box, click Security Tab.
Step 23 Click Edit…, as shown in FIGURE 2-25.

FIGURE 2-25 UploadImages Properties - Security
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Step 24 On the Permissions dialog box, click Add..., as
shown in FIGURE 2-26.

FIGURE 2-26 Permissions for UploadImages - Add
Step 25 In the Enter the object names to select, type in
the name of the user account, or the default name
UploadUser, if applicable, as shown in FIGURE 2-27.

FIGURE 2-27 Select User or Groups - Upload User

2-24
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Step 26 Make sure the From this location references your
computer.
Step 27 Click Check Names.
Step 28 Click OK on both dialog boxes.
Step 29 On the Security tab of the Properties dialog box,
click the user account name, or the default name
UploadUser, if applicable, as shown in FIGURE 2-28.
Step 30 Click Advanced.

FIGURE 2-28 UploadImages Properties - Advanced
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Step 31 On the Advanced Security Settings dialog box,
click the Permissions tab.
Step 32 Click the user account name, or the default
UploadUser, if applicable, as shown in FIGURE 2-29.
Step 33 Click Change Permissions….

FIGURE 2-29 Advanced Security Settings for UploadImages - Change Permissions
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Step 34 Click Edit..., as shown in FIGURE 2-30.

FIGURE 2-30 Advanced Security Settings for UploadImages - Edit
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Step 35 For Permission Entries, select the following
Allow rights, as shown in FIGURE 2-31:
• List folder/read data
• Read attributes
• Read extended attributes
• Create files/write data
• Create folders/append data
• Write attributes
• Write extended attributes
• Delete sub-folders and files
• Delete
• Read permissions

FIGURE 2-31 Permissions Entry for UploadImages - Upload User
Step 36 Click OK on all dialog boxes.
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Setting up FTP Servers
Setting up an FTP server allows you to upload the
NoiseTutor client reports. The FTP server root folder should
be specified as the sub-folder “UploadImages” for the web
server. To set up the FTP server, follow these steps:
Step 1 From the Start menu, click Computer. Browse to
c:\windows\system32\inetsrv\inetmgr.exe.
Step 2

Double-click inetmgr:

Step 3 Under Connections on the Internet Information
Services (IIS) Screen, click the local computer icon to
expand it, as shown in FIGURE 2-32.
Step 4

Click Content View, as shown in FIGURE 2-32.

Step 5
32.

Click Add FTP Site…, as shown in FIGURE 2-

FIGURE 2-32 IIS Service Manager - Add FTP Site
NoiseTutor System Manual
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Step 6 On the Site Information page of the Add FTP Site
wizard, type Upload Images FTP Site for the FTP site
name, as shown in FIGURE 2-33.
Step 7 Under Physical path: type
c:\inetpub\wwwroot\LarsonDavis\UploadImages, as
shown in FIGURE 2-33, or browse to the folder and select it.
Step 8

Click Next.

FIGURE 2-33 Add FTP Site - Site Information
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Step 9 On the Binding and SSL Settings page, Select All
Unassigned for IP Address, as shown in FIGURE 2-34.
Step 10 Specify the port for the FTP site, as shown in
FIGURE 2-34. The default is 21.
Step 11 Clear the Enable Virtual Host Names option.
Step 12 Select Start FTP Site Automatically.
Step 13 Select No SSL.
Step 14 Click Next.

FIGURE 2-34 Add FTP Site - Binding and SSL Settings
Step 15 On the Authentication and Authorization
Information page, select Basic for Authentication.
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Step 16 Select Specified Users for Allow access to:
Step 17 Type in your user account name, or the default
UploadUser, if applicable, as shown in FIGURE 2-35.
Step 18 Select Read and Write under Permissions.
Step 19 Click Finish.

FIGURE 2-35 Add FTP Site - Authentication and Authorization Information
Step 20 Close IIS.

Configuring Windows Firewalls
Firewalls are used to restrict remote access to your
computer. If you have a firewall present, you will need to
allow web and FTP access. Below is an example for
configuring Windows® Firewalls. For other firewalls, refer
to the documentation from that provider.
Step 1
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From the Start menu, click Control Panel.
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If Windows Firewall is not displayed
in your Control Panel, click the drop
down arrow in the address bar
following the words “Control
Panel.” Click All Control Panel
Items. The Windows Firewall icon
should appear with other icons in
your Control Panel.

Step 2

Click Windows® Firewall.

Step 3
2-36.

Click Advanced Settings, as shown in FIGURE

FIGURE 2-36 Windows Firewall - Advanced Settings
Step 4 On the Windows Firewall with Advanced Security
screen, click Inbound Rules, as shown in FIGURE 2-37.
Step 5
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Click New Rule..., as shown in FIGURE 2-37.
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FIGURE 2-37 Windows® Firewall with Advanced Security - New Rule
Step 6 On the Rule Type page of the New Inbound Rule
Wizard, select Predefined: as shown in FIGURE 2-38.
Step 7

Select FTP Server, as shown in FIGURE 2-38.

Step 8

Click Next.

FIGURE 2-38 Windows Firewall - New Inbound Rule Wizard - Predefined (FTP Server)
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Step 9 On the Predefined Rules page, select FTP Server
Passive (FTP Passive Traffic-In), as shown in FIGURE 239.
Step 10 Select FTP Server Secure (FTP SSL Traffic-In),
as shown in FIGURE 2-39.
Step 11 Select FTP Server (FTP Traffic-In), as shown in
FIGURE 2-39.
Step 12 Click Next.

FIGURE 2-39 Windows® Firewall - New Inbound Rule Wizard - FTP Rules
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Step 13 On the Action page, select Allow the connection,
as shown in FIGURE 2-40.
Step 14 Click Finish.

FIGURE 2-40 Windows® Firewall - New Inbound Rule Wizard - FTP (Allow the
connection)
Step 15 On the Windows Firewall with Advanced Security
screen, click Inbound Rules, as shown in FIGURE 2-41.
Step 16 Click New Rule…, as shown in FIGURE 2-41.

FIGURE 2-41 Windows® Firewall with Advanced Security - New Rule
2-36
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Step 17 On the Rule Type page, select Predefined:, as
shown in FIGURE 2-42.
Step 18 Select World Wide Web Services (HTTP), as
shown in FIGURE 2-42.
Step 19 Click Next.

FIGURE 2-42 Windows Firewall - New Inbound Rule Wizard - Predefined (World Wide
Web)
Step 20 On the Predefined Rules page, select World
Wide Web Services (HTTP Traffic-In), as shown in
FIGURE 2-43.
Step 21 Click Next.

NoiseTutor System Manual

2-37

FIGURE 2-43 Windows® Firewall - New Inbound Rule Wizard - Rule (World Wide Web)
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Step 22 On the Action page, select Allow the connection,
as shown in FIGURE 2-44.
Step 23 Click Finish.

FIGURE 2-44 Windows® Firewall - New Inbound Rule Wizard - Allow the Connection
Step 24 Close the Windows Firewall with Advanced
Security screen.
Step 25 Close the Windows Firewall.

Verifying Access to FTP Servers
Local Access
Verify your access to the FTP server from your server
(local), by following these steps:
Step 1 Make sure the FTP server is running. Click Start
in IIS if it is not, as shown in FIGURE 2-45.
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FIGURE 2-45 IIS Manager - FTP Server Running
Step 2 Verify that the user name and password are valid
for the server. If not, use the user name and password
supplied by the administrator, or add the user name and
password to a user account for the server machine.

Local Network Access
Verify your access to the FTP server from another machine
on the same network, by following these steps:
Step 1 Follow the steps for verifying that your server can
access the FTP server.
Step 2 Verify that the FTP server's firewall allows FTP
traffic, as shown in FIGURE 2-46.
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Local Network Access
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FIGURE 2-46 Windows® Firewall with Advanced Security - FTP Services Allowed
Step 3 Type your IP address into the address bar of your
browser. Verify that the browser loads correctly, as described
in the following section.

Public Access
If you have a public FTP firewall on
your network, you will need help
from your network administrator.

Verify your access to the FTP server from another network
(public), by following these steps:

The FTP site address must be
publicly accessible to receive data.

Step 1 Follow instructions in Accessing FTP server from
another machine on the same network.
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Public Access
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Step 2 Verify that the router has port forwarding or port
triggering rules for the FTP port, as shown in FIGURE 2-47.

FIGURE 2-47 Router Port Forwarding - FTP Service

Verifying Browser Connections
To verify your browser is connected and loads correctly,
follow these steps.
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Public Access

Step 1
server.

Verify that the website is available on the web

Step 2

Open Internet Explorer.
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Step 3 In the address bar, type http://localhost/
LarsonDavis/index.html.
Step 4 If the main web page does not appear, verify that
the web service is running. Click Start in IIS if it is not, as
shown in FIGURE 2-48.

FIGURE 2-48 IIS Manager - Website Running
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Public Access
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Step 5 Verify that the proxy user or supplied user has read
access permissions, as shown in FIGURE 2-49. If not, grant
read access to the proxy user or supplied user.

FIGURE 2-49 Larson Davis Properties - Web User Access Rights
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Step 6 Verify that the file index.html is located in the
virtual directory, as shown in FIGURE 2-50. If not, run
ConfigurationTool.exe again.

FIGURE 2-50 IIS Manager - Index.html Present
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Public Access
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Step 7 To ensure access to your web site from another
computer, verify that the server's firewall allows traffic
through the web site port (Default 80), as shown in FIGURE
2-51. Change the firewall if needed.

FIGURE 2-51 Windows® Firewall With Advanced Security - World Wide Web
If your web server does not have a
public IP address, you will need to
configure your routers for access.
Consult with your organization IT
professional for help.
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Public Access

Step 8 To ensure access to your website from the Internet
(and not just your local network), verify that the router has
port forwarding or port triggering rules for your web site.
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CHAPTER

3

Station Installation and
Setup
This chapter provides instructions for setting up the
NoiseTutor Station, including software, licenses, settings,
preferences, and data communication. For best results,
perform the procedures in the order they are presented in the
following sections.

Installing NoiseTutor Software
Important: NoiseTutor software is
pre-installed when NoiseTutor is
purchased as a system. If you
purchased a system, skip to the
following section, “Starting the
NoiseTutor Station” on page 3-3.

If your NoiseTutor Station was not purchased as part of a
system, or if for some other reason you need to install the
NoiseTutor software, insert the CD into your station
computer (not the server computer) and follow the
instructions on the installation wizard.
During the setup process, a link to the NoiseTutor software
is created in the Startup folder of the Windows® operating
system. As a result, the NoiseTutor software runs every time
Windows is started. It also enables the NoiseTutor Station to
automatically restart Windows without user intervention.
The link to the Windows Startup folder starts the NoiseTutor
System as a program, but it does not automatically start
monitoring operations. If Windows is restarted while the
NoiseTutor System is opened and running (see Main
Commands), the program stores the previous state, and upon
restart it reactivates the monitoring operations.
If you want the monitoring operations to start automatically
each time the Windows® operating system starts up, follow
these steps:
Step 1 Browse to the NoiseTutor link in the Windows
Startup folder.
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Step 2 Right-click the NoiseTutor icon and click
Properties, as shown in FIGURE 3-1.

FIGURE 3-1 NoiseTutor Application Properties Access
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Step 3 In the Target field, replace C:\Program
Files\NoiseTutor\NoiseTutor.exe with C:\ProgramFiles\
NoiseTutor\NoiseTutor.exe -R, as shown in FIGURE 3-2.

FIGURE 3-2 NoiseTutor Properties

Starting the NoiseTutor Station
Refer to the NoiseTutor Quick Start
Guide
and
the
NoiseTutor
Installation Reference on the inside
of the NoiseTutor System case to set
up your hardware.
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With the necessary hardware installed, follow these steps to
start the NoiseTutor Station:
Step 1

Press the black power switch to start the system.
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Step 2 Press the monitor power button to activate the
display.
Step 3 Remove the keyboard and slide the keyboard
switch to ON.
Note: Slide the keyboard switch to
OFF when not in use.

Step 4 Verify that the network utility has connected to a
cell network.
Step 5 When the wireless modem utility has connected to
the cell network, minimize the utility.

Installing NoiseTutor Station Licenses
Your license may be pre-installed if
you receive a new sound level meter
as part of your NoiseTutor Station.

The NoiseTutor Station requires an activation license in
order to be used. The license files you receive are based on
the model and serial number of the sound level meter. Please
contact PCB Technical Support to obtain license files. To
install the license file, follow these steps:

If you received the license file as a
zipped file, remember to unzip it
first. Otherwise, NoiseTutor will not
recognize it as a license file.

Step 1 Copy all license files you receive from PCB to
your clipboard. Your license files may be sent to you
through e-mail. If you receive them by some other
method and are copying your license using USB flash
memory, insert the USB drive into the USB connector.
Do not disconnect the USB keyboard dongle to insert
your USB flash memory. This is shown on the
Installation Reference located on the inside of the front
cover of the station case.

The license file is named in the
following file naming format:
NT_831_LxT_XXXX.lic,
where
XXXX represent the last four
numbers of the sound level meter
serial number being used in the
system.
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Step 2

Launch the NoiseTutor Software.

Step 3

From the View menu, click NoiseTutor Folder.

Step 4

Paste the license file into NoiseTutor folder.
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If your are copying your license
using USB flash memory, insert your
memory into the drive port. Do not
disconnect the USB keyboard dongle
to insert your USB flash memory.

If your license was not factory installed for your sound level
meter and you received it via another method, copy the file
from the source where you receive it and paste it according
to the directions provided above.
You can check the status of your license files by clicking
Help and then clicking About NoiseTutor.... The license
status window is shown in Figure 3-3.

FIGURE 3-3 License Status Window
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Checking Battery Status
If the Model 831 is ON, pressing the 0 (ON/OFF) key
displays the Power Control screen, as shown in Figure 3-4.

On the Power Control Screen, the
values associated with “Estimated
Run Time,” “Battery Type,” and
“Battery” are not applicable to the
NoiseTutor station and should be
disregarded while the sound level
meter is part of the station.

FIGURE 3-4 Power Control Screen
To check the voltage of the battery, refer to the value
indicated next to “Ext Powered.”
Make sure you recharge the battery
before the value on the Ext Powered
displays 12.4 volts or less, or 11.0 if
your system is configured for
optional sealed lead-acid batteries.

The fully-charged lithium ion battery for the NoiseTutor
station carries 14.4 volts; when the battery depletes to 12
volts, the sound level meter powers off. You can also check
the battery condition by pressing the switch button on the
front of the battery. Refer to the battery manual for more
information.

Checking the Station PC Power Settings
To check the power settings on the Station PC in the
NoiseTutor station, follow these steps:
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The settings in this section are the
default power saving options for the
Station PC. If your Station PC has
had its settings altered, you can
follow the steps in this section to
restore the default settings.

Step 1

From the Start menu, click Control Panel.

Step 2

Click Power Options.

Step 3 Specify the default time settings as shown in
Figure 3-5.

FIGURE 3-5 Station PC Default Power Settings
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Step 4 Click Change advanced power settings, as
shown in Figure 3-6.

FIGURE 3-6 Advanced Power Settings
Step 5 On the Advanced Settings tab, expand Battery
and Critical battery action. For the On battery entry,
specify Shut down if not already selected; for the Plugged
in entry, specify Do nothing if already not selected. The
settings are shown in Figure 3-7.

FIGURE 3-7 Critical Battery Action Settings
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Step 6 On the Advanced Settings tab, expand USB
Settings and USB Selective Suspend Setting. For the On
battery entry, specify Disabled if not already selected; for
the Plugged in entry, specify Enabled if not already
selected. The settings are shown in Figure 3-8.

FIGURE 3-8 USB Settings
Step 7 If you made any changes, click OK on the
Advanced Settings tab and then click Save changes on the
Power options dialog box
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Restoring Settings for Automatic Wakeup
Your NoiseTutor Station is shipped with automatic wakeup
already configured. If this setting has been altered, you can
restore it by following these steps:
Step 1 Click Control Panel > Power Options > and then
click Change advanced power settings as shown
previously in Figure 3-6.
Step 2 On the Advanced Settings tab, expand the fitPC2 setting and then expand Require a password on
wakeup.
Step 3 For both On battery and Plugged in settings,
select No.

FIGURE 3-9 Wakeup Password Setting
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Step 4 Expand the Sleep setting from the same list on the
Advanced Settings tab and then expand Allow wake
timers.
Step 5 For both On battery and Plugged in settings,
select Enable.
Step 6

Click Apply and then click OK.

FIGURE 3-10 Wakeup Timer Setting

Setting Up Power Saving
If power saving is needed, follow these steps on the System
Setup dialog box:
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FIGURE 3-11 Power Saving Setup
Step 1 Launch the NoiseTutor software and click Setup >
System.
For NoiseTutor systems that are
optionally powered by sealed leadacid batteries, set the sleep and
shutdown voltage as 11.0
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Step 2 In the System Setup dialog box, configure the
following options:
•

For Restart Windows every, Specify the number of
days that the Station PC should wait before rebooting on
a regular basis. This may be helpful because the
Windows® operating system can become unstable if the
system operates for long periods of time.

•

Select Sleep between every file download.

•

Specify the Sleep voltage as 12.8 V and Shutdown
voltage as 12.4.

•

For regular times when monitoring is not needed, specify
Sleep at a fixed time.
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Do not select Hibernate power
saving mode. Selecting this mode
prevents the Station PC from
waking up.

•

For Select operation for power saving specify Standby
to enable power saving and put data in memory without
turning off the computer. This option is disabled if with
Realtime Reports.

•

If realtime data is not needed, select Disable. and specify
remote maintenance connection times, if needed.

•

For Keep the PC on for remote maintenance
connection: Select these options to have the Station PC
on during two time periods every day, independently of
other configurations, so that administrative tasks can be
performed remotely.
• For Period 1 Starting from: specify a beginning
time in 24-hour notation for when the Station PC
should be turned on.
• For Duration: specify the duration of time the
Station PC should be turned on. The times
specified for this setting are referenced by the
internal clock time on the Station PC, regardless of
actual time.
• If an additional time period is needed, specify the
time and duration for Period 2 in the same manner
as specified for Period 1.
• For remote operation, choose any remote software
package that is compatible with Windows 7®.
• If you are using a dial-up connection with a
wireless modem, you may need to set the dial-up
software to automatically connect when Windows
is started.

Step 3

Click OK. You will need to restart Windows.

Checking the NoiseTutor Model 831 Run
Preferences
To check the Run preferences on the model 831 in the
NoiseTutor station, follow these steps:
Step 1 Press the softkey under Menu on the model 831
display.
Step 2
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Select Settings and press 5.
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Step 3
by PC.

Press 5 again on Yes to confirm Settings in use

Step 4

Use the left softkey to scroll to the Control tab.

Step 5 Check the Run Mode and Auto-Store Preference
selections. The default settings are shown in Figure 3-12.
You can specify other Run
preferences on the Control tab, such
as Enable Measurement History or
Cal-Check, without affecting the
default Run preferences described
here.

FIGURE 3-12 Model 831 Run Preferences
To modify the Run preferences for the model 831, scroll to
Run Mode or Auto-Store, as shown in Figure 3-12, and
select the desired option from the drop down menu, and then
press 5.
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Monitoring the Wireless Modem Connection
The NoiseTutor station includes the Sierra Wireless®
modem. Additionally, the Sierra Wireless ACEview utility is
installed on the Station PC for monitoring the status of the
wireless connection. Figure 3-13 shows the ACEview icon
as it appears on the Station PC desktop:

FIGURE 3-13 ACEview Modem Utility Icon
The shutoff voltage setting in the
Sierra Wireless client should be 12.0
for internal, LiFePo3 batteries and
10.8 for external SLA batteries.

Refer to the Sierra Wireless User Guide and the ACEview
User Guide for more information on the wireless modem
and the ACEview utility.

Specifying Main Application Settings
Before configuring NoiseTutor Station data delivery
features, the main applications settings must be specified in
the Main Setup dialog box.
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FIGURE 3-14 shows the Main Setup dialog box.

FIGURE 3-14 Main Setup
To specify the main settings, follow these steps:
Step 1

On the Setup menu, click Main Setup.

Step 2 Refer to FIGURE 3-14 while entering the
following information:
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•

Station name: Type the name of your monitoring
station.

•

Archive Folders: Specify the folders on the local hard
disk where the downloaded files are to be saved. To
select locations other than the default, click the ... button
and navigate to the new location.

•

Select the zip files before sending to mail or ftp option
to send compressed files. Zipping files is recommended.

•

Check Instrument Time: Specify how often the Station
PC should check the sound level meter internal clock to
verify synchronization with the PC clock. Checking the
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internal clock does not require a stop in measurement,
but changing the internal clock requires a stop. Choose
between the following options:
•
•
•
•
•
•
•
•
•

Never
Every download
1 day
2 days
3 days
4 days
5 days
6 days
7 days

•

Update when difference is greater than: Specify the
value, in seconds, when the difference between the
instrument internal clock and the Station PC clock merits
updating the internal clock.

•

Spectrum extension: Specify the octave spectrum size
to be measured. Choose between 20Hz-20kHz or Full
Spectrum.

•

Check for new files: Specify a time period for the
Station PC to wait between download operations. If the
Synchronize option is selected, the download time is
synchronized at the specified hour, starting from
midnight.

•

Synchronize clock: Use SNTP Internet time service to
keep the NoiseTutor clock synchronized independent of
PC clock drifts. No changes are made to the PC clock.
The default settings apply to most setups.

Configuring Data Transmission and Delivery
Settings
Configuring data transmission and delivery settings for the
NoiseTutor Station includes the following procedures:

The NoiseTutor Station does not
support SSL connections for SMTP
(e-mail).
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1.
2.

Setting up SMTP and SMS Messaging Services
Adding E-mail and SMS Recipient Lists

3.
4.
5.
6.

Specifying Data Settings for E-mail Messages
Setting up Data Delivery for FTP Server Sites
Specifying Real-time Report E-mail Settings
Creating and Publishing Graphical Reports to Websites
3-17

7.

Updating Webpages from the NoiseTutor Station

The following two sections describe the procedure for
configuring these services.

Set Up SMTP (E-mail) Service
To deliver data files and graphical reports via e-mail, you
must first configure SMTP service settings on the
NoiseTutor Station.
To set up the NoiseTutor Station for SMTP (e-mail) service,
follow these steps.
For more information on SMTP
setup, refer to “Messaging” on page
5-6.

Step 1

On the Setup menu, click Messaging < SMTP.

Step 2 Refer to FIGURE 3-15 while entering the
following information:

FIGURE 3-15 SMTP (E-mail) Setup
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•

SMTP mail server: Specify the name of your SMTP
mail server. Usually, this address is provided by your
Internet service provider.

•

Send Address: Specify the e-mail address to be used to
send data files and that is hosted by the SMTP mail
server specified.

•

Use encrypted secure connection: Select this option to
use a secure connection to the mail server. Only the
STARTTLS mechanism is supported.

Set Up SMTP (E-mail) Service
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If you set up the NoiseTutor Station
to e-mail data files, the graphs in the
message are based on the data file. If
you want to view spectral data in the
message, you must enable logging
for spectral data on the sound level
meter. See the technical reference
manual for your sound level meter
for more information.

•

Use E-mail authentication: Select this option if your
SMTP mail server requires a Login name and Login
password.

•

SMTP Port: Specify the port number reserved for mail
by your organization. Consult with your network
administrator to verify the correct number.

•

Login Name and Login Password: Specify the login
name and password you want to use to access e-mail on
your SMTP mail server, if authentication is requested.

•

In the Information request address field, type the email address of the designated personnel to handle data
inquiries.

•

Send test e-mail...: Provide an address to send a test
message. After sending, the Station PC displays the
results and content of the SMTP test.

Step 3

Click OK.

Set Up SMS (Text Messaging) Service
To deliver sound level information through text messaging,
you must first configure SMS service settings on the
NoiseTutor Station.
To set up the NoiseTutor Station for SMS (text messaging),
follow these steps.
For more information on SMS setup,
refer to “Messaging” on page 5-6.
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Step 1

On the Setup menu, click Messaging < SMS.

Set Up SMS (Text Messaging) Service
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Step 2 Refer to FIGURE 3-16 while entering the
following information:
SMS service, when used with the
Event Detection feature, can be
helpful in providing notification of
specified
events.
For
more
information, see “Event Detection”
on page 5-17.

FIGURE 3-16 SMS Setup

•

Mobile phone or modem port: Specify the COM port
where the mobile phone or modem is connected. Access
is always through a COM port, even with integrated
modems. The correct number may be found through the
Device Manager in Windows 7®.

•

Baud-rate: Specify the desired communication speed
between the Station PC and the device.

•

SIM card activation PIN: Type the PIN of your SIM
card. Leave this field empty if the PIN request is not
activated or not needed for your SIM.

•

Send test SMS...:Sends a test SMS, or text message.
After sending, the Station PC displays the results and
content of the SMS test.

Step 3
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Set Up SMS (Text Messaging) Service

Click OK.
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Add E-mail and SMS Recipient Lists
The NoiseTutor Station uses recipient lists to send sound
level data. To add recipient lists, follow these steps:
For more information on setting up
and specifying recipient lists for email and text messaging, see
“Recipient Lists” on page 5-4.

Step 1

On the Setup menu, click Recipient Lists.

Step 2 On the Recipient Lists dialog box, click the New
list button in the lower left corner of the dialog box.
Step 3 For List name, type the name of the new recipient
list, as shown in FIGURE 3-17.

FIGURE 3-17 Recipient List Set-up
Step 4 To add e-mail and SMS information for a recipient
on the list, click the Add... button.
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Add E-mail and SMS Recipient Lists
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Step 5 On the Recipient dialog box, type the Name, Email address and SMS number of the recipient to be added
to the list.
Step 6 Click OK and repeat this step for every recipient
you want to add to the list.
Step 7 Click the New List button to create additional
recipient lists, as shown in FIGURE 3-17.
Step 8

Click OK to exit the Recipient Lists dialog box.

Specify Data Settings for E-mail Messages
The NoiseTutor Station can send both data files and
graphical reports via e-mail. First, you must set up the
SMTP Service settings for the NoiseTutor Station, as
described previously. After setting up SMTP service, you
specify the content, or data, to be included in e-mail
messages.
To specify the data to be included in e-mail messages, follow
these steps:
Step 1 On the Setup menu, click Data File, and then
click E-mail 1…. This launches the E-mail Data File 1
Service Setup dialog box, as shown in FIGURE 3-18.
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Specify Data Settings for E-mail Messages
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FIGURE 3-18 E-mail Data File Service Setup
Step 2 Select Enable E-mail data file …, as shown in
FIGURE 3-18.
Step 3 For Recipients list, select the recipient list to
which the sound level data will be sent.

For more information on Time
History graphs and Sonograms, see
“Graph” on page 5-9.

Step 4

For Subject, type the subject title.

Step 5

For Message text, type the e-mail message.

Step 6 In the Attachments section, select the graphic
report attachment to include in the e-mail. You can select
Time History 1, or Sonogram, or both.
Step 7 Specify the height and width dimensions for the
graphs in the attachments.

You can view Slmdl data files in the
G4 LD Utility software.
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Step 8 Select Slmdl Data File to attach the data file from
the NoiseTutor Station sound level meter.

Specify Data Settings for E-mail Messages 3-23

Audio files can also be sent via email when specified events are
detected by the NoiseTutor Station.
For more information, see “Event
Detection” on page 5-17.

Step 9 Select the Include the PC power status
information to include the Station PC power information.
Step 10 Click OK.
Step 11 Verify that Internet Upload on the Commands
menu is checked.
Step 12 Configure other NoiseTutor data transmission
options and begin taking sound level data by clicking Start
on the Commands menu.
Step 13 To setup a second e-mail service, click Setup <
Data File < Email 2... and repeat the previous steps.

Specify Real-Time Report E-mail Settings
The NoiseTutor Station can send real-time graphical reports
via e-mail. After setting up SMTP service, you specify the
real-time reports to be included in e-mail messages.
To specify the data to be included in e-mail messages, follow
these steps:
Step 1 On the Setup menu, click Realtime Report, and
then click E-mail 1…. This launches the E-mail Report
Service Setup dialog box, as shown in FIGURE 3-19.
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FIGURE 3-19 Realtime Report E-mail Service Setup
Step 2 Select Enable E-mail report service, as shown in
FIGURE 3-19.
Step 3 For Recipients list, select the recipient list to
which the real-time report is to be sent.
Step 4

For Subject, type the subject title.

Step 5

For Message text, type the e-mail message.

Step 6 For Send report every, specify how often the
real-time report is to be sent.
For more information on Time
History graphs and Sonograms, see
“Graph” on page 5-9.

Step 7 In the Graphic report to attach section, select the
graphic report attachment to include in the e-mail.
Step 8 Specify the height and width dimensions for the
graphs in the attachments.
Step 9
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Click OK.
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Step 10 Verify that Internet Upload on the Commands
menu is checked.
Step 11 Configure other NoiseTutor data transmission
options and begin taking sound level data by clicking Start
on the Commands menu.
Step 12 To setup a second real-time report e-mail service,
click Setup < Realtime Report < Email 2... and repeat the
previous steps.

Set up Data Delivery for FTP Server Sites
To publish graphical reports from
FTP sites to websites, first set up
data delivery on your FTP site, as
described in this section, and then
see the following section, “Create
and Publish Graphical Reports to
Websites” on page 3-27.

If you have a public FTP firewall on
your network, you will need help
from your network administrator.
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By setting up an FTP site for data delivery, you can do the
following:
•

Receive sound level data files

•

Publish graphical reports of data files on websites

•

Publish realtime reports of sound measurements on
websites

•

Receive and publish event detection reports

•

Receive and post audio recordings of measurements to
websites

•

To set up data delivery for FTP sites, follow these steps:

Step 1 On the Setup menu, click Data File and then click
FTP 1… This launches the FTP 1 Service Setup dialog
box, as shown in. FIGURE 3-20

Set up Data Delivery for FTP Server Sites
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FIGURE 3-20 FTP Service Set-up
Step 2 On the FTP1 Service Setup dialog box, select the
Enable the FTP1 service option.
The FTP site address must be
publicly accessible to receive data.

Step 3 Specify an FTP site address by typing your user IP
address, the local host IP address, or a domain name.

Larson Davis strongly recommends
that you specify, select, or accept all
defaults for your configuration, as
demonstrated in this manual.

Step 4

Type the default FTP site User name UploadUser.

Step 5

Type an FTP site password.

Step 6 If you have specified the default values in
configuring your server, as shown in this manual, type a
forward slash (/) for Folder name. This specifies your virtual
directory. Otherwise, type the path to the location you have
specified in configuring your server.
Step 7

Click OK.

Step 8 Verify that Internet Upload on the Commands
menu is checked.
Step 9 Configure other NoiseTutor data transmission
options and begin taking sound level data by clicking Start
on the Commands menu.

Create and Publish Graphical Reports to Websites
Note: The NoiseTutor Station View
menu enables the display of log files,
where operations are recorded. It
also enables the log of Internet
connection statistics, or the logs of
debug messages. Such log files can
be helpful in debugging wireless
modem dial-up connections.
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To create and publish reports of sound level data to websites,
follow these steps:
Step 1 Create a website that accepts graphical reports.
This can be done using the NoiseTutor Server Configuration
Tool located on the NoiseTutor CD.
Step 2 On the Setup menu, click Realtime Report and
then click Web1…. This launches the Web Report Service
Setup dialog box, as shown in Figure 3-21.
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FIGURE 3-21 Web Report Service Setup
Step 3 On the Web Report Service Setup dialog box,
select Enable the web report service.
Step 4 Specify the FTP site address by typing your user
IP address or the local host IP address.
Larson Davis strongly recommends
that you specify, select, or accept all
defaults for your configuration, as
demonstrated in this manual.

Step 5

Type the default FTP site User name UploadUser.

Step 6

Type your FTP site password.

Step 7 If you have specified the default values in
configuring your server, as shown in this manual, type a
forward slash (/) for Folder name. This specifies your virtual
directory. Otherwise, type the path to the location you have
specified in configuring your server.
Step 8 Click New…. This launches the Web Graph
dialog box, as shown in FIGURE 3-22
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This example shows the settings for 5
week (monthly) reporting time,
including the filename that should be
used.

FIGURE 3-22 Web Graph
Step 9 Select the reports to be published to the website.
You can select Time History, or Sonogram, or both.
Step 10 For History, select the template of the Time
History report.
Step 11 For Time Length, select the length of the time
axis in the graphical reports. The graphs display the last
captured data, independent of the length of the axis.
Step 12 For Update Every, select how often to receive
updates. For best results, specify an interval time similar to
Time Length.
Step 13 For Width and Height, specify the size of the
image in pixels.
Step 14 For Additional Data Displayed, select additional
options for displaying data, including Hourly levels, Ldn,
LN, Day/Evening/Night levels, and Lden.
The filename
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Step 15 For Filename, verify that the destination location
on the FTP server is specified according to reporting times,
as follows:
• %SN%_%MODEL%_RT_10M.jpg for Time
length of 10 min
• %SN%_%MODEL%_H1_1H.jpg
length of 1 hour
• %SN%_%MODEL%_H1_24H.jpg
length of 1 day

for Time
for Time

• %SN%_%MODEL%_H1_1W.jpg
length of 1 week

for Time

• %SN%_%MODEL%_H1_5W.jpg
length of 5 weeks

for Time

Step 16 Click OK.
Step 17 Verify that Internet Upload on the Commands
menu is checked.
Step 18 Begin taking sound level data by clicking Start on
the Commands menu.

Connecting with WiFi
Refer to your router manual and
consult with a network professional
for proper WiFi connectivity results.
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The embedded PC within the NoiseTutor Station is capable
of WiFi communications. However, the range for successful
WiFi communications is dependent upon variables in your
environment, including distance, barriers, elevation changes,
and router quality. To position the NoiseTutor Station for
best reception, place the case upright with the cable glands
away from the WiFi router.

Create and Publish Graphical Reports to Websites
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Router Location

WiFi Antenna
FIGURE 3-23 WiFi Orientation
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CHAPTER

4

Wireless Gateway Setup for
SMS Messaging
This chapter provides instructions for setting up and using
the Sierra Wireless® modem Gateway for NoiseTutor Station
SMS messaging. The modem provides data service for the
NoiseTutor Station with its default settings; however, for
SMS messaging, additional configuration is needed on both
the Sierra Wireless Modem and the NoiseTutor Station.

Configuring the Sierra Wireless Modem for SMS
Messaging
To configure the Sierra Wireless Modem for SMS
messaging, follow these steps:
Step 1 Ensure that the Sierra Wireless Modem has an
active SIM card associated with a data plan (purchased
separately).
Step 2 Connect the modem to the Station PC with a
CAT5 cable (sold separately) and turn on the modem.
Form
more
information
on
AceManager, refer to the Sierra
Wireless Modem user guide.
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Step 3 To launch AceManager--the Sierra Wireless
Modem configuration software--open a web browser and
enter the following IP Address into the Address bar: http://
192.168.13.31:9191. If the login shown below does not
appear, reboot the Station PC and repeat this step.

Wireless Gateway Setup for SMS Messaging 4-1

FIGURE 4-1 Sierra Wireless Modem AceManager
Login
Step 4 Enter the default administrator user name and
password for the AceManager login, as follows:
This is the default username and
password for the Sierra Wireless
modem. Use AceManager to change
the password by going to Admin
Change Password.

Username: user

Remote
administration
access
limited to SSL only on port 9449.

Step 6 On the left side of the screen, click SMS from the
vertical list.

Password: LD_NMSystem16
Step 5 After successful login, click the AceManager
Services tab.

Step 7 Under SMS Mode, select Gateway Only from the
first drop-down list.
Step 8 Under Local Host Interface Configuration, enter
17341 in the ALEOS Port field.
Step 9

Click Apply and then reboot the Station PC.

The Sierra Wireless® modem is now configured for SMS
messages using UDP port 17341.

4-2
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FIGURE 4-2 AceManager SMS Configuration

Configuring the NoiseTutor Station for SMS
Messaging
To configure the NoiseTutor Station for SMS messaging,
follow these steps:
Step 1 In the NoiseTutor software, click Setup >
Messaging > SMS....
Step 2 In the Select SMS Protocol drop-down list, select
Sierra Wireless IP-SMS.
For information on configuring SMS
messaging for Event Detection, see
“Event Detection” in Chapter 5.
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Step 3 In the Modem IP address field, enter
192.168.13.31.
Step 4
17341.

In the Modem UDP port field, enter the number
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Step 5 Click Send test SMS to verify that SMS messages
can be sent on the system and then click OK.
The NoiseTutor Station is now configured for SMS
messages.

FIGURE 4-3 Sierra Wireless® SMS Messaging Setup
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CHAPTER

5

Station Software Reference
This chapter provides information for configuring your
station with the commands in the Setup and Commands
menus of the NoiseTutor station.
You can view the features you have configured through the
Setup menu by clicking the Status button on the NoiseTutor
application window and viewing the Status display, as
shown in Figure 5-1.

FIGURE 5-1 Status Display
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Setup Commands
The Setup commands described in
this chapter apply to the NoiseTutor
station, not the server.

Figure 5-2 shows the Setup menu commands for the
NoiseTutor station.

FIGURE 5-2 Setup Menu Commands
Table 5-1 lists the commands in the Setup menu and
describes their basic functions.

Command

Usage

Main Setup

Changes main application settings.

System Setup

Specifies setup options

Recipient Lists

Defines the recipient lists used in e-mail or SMS services.

Messaging
Graph

Specifies the settings for graphs used in E-mail messages for
web publishing.

Audio Recording

Specifies settings for audio recordings.

Event Detection

Specifies settings for event detection.

Data File (E-mail)

5-2

Specifies settings for SMTP or SMS messaging.

Specifies settings for graphs used in e-mail messages and for
web publishing.
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Command

Usage

Data File (FTP)
Realtime Report (E-Mail)

Specifies settings for FTP upload services used in “Data File”
working mode.
Specifies settings for e-mail services used in the “Realtime
Report” working mode.

Realtime Report (Daily, Weekly, Specifies settings for daily reporting services used in the
Monthly)
“Realtime Report” working mode.
Realtime Report (Web)
Administration Messages

Specifies settings for web publishing services.
Specifies settings for e-mail or SMS messages sent to system
administrators.

Table 5-1 Setup Commands and Functions

Main Setup
The Main Setup dialog box is shown in FIGURE 5-3.

FIGURE 5-3 Main Setup
Table 5-2 describes the settings for the Main Setup dialog
box.
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Setting
Station Name

Description
The name of your monitoring station.

Archive Folders

The folders on the local hard-disk where the downloaded files
are saved. To select another location, click the ... button and
navigate to the new location.

Zip files before...

Select this check box to zip the data files before attaching to
an e-mail, or uploading to an FTP site.

Check Instrument time

All supported instruments have an internal clock. Use this
field to keep the internal clock synchronized with the Station
PC clock. Checking the clock does not require a stop in measurement. To change the internal clock, the measurement must
be stopped and then restarted again after the clock change.
Setting options include: Never, Every download, 1 day, 2
days, 3 days, 4 days, 5 days, 6 days, and 7 days.

Update when difference is greater The value in seconds used to check the internal clock. When
than
the difference between internal clock and Station PC clock is
greater than this value, the internal clock is updated.
Spectrum extension

The octave spectrum size to be measured. Select either 20 Hz20 kHz, which is normally used for acoustic measurements, or
Full spectrum.

Check files
(Data File Download)

Sets the time between two download operations. If the synchronize check box is selected, the download time is synchronized at the specified hour, starting from midnight.

Synchronize clock with Internet Synchronizes NoiseTutor clock with SNTP time without
Time
changing the PC clock.
Table 5-2 Main Setup Options

Recipient Lists
The Recipient Lists dialog box allows you to define the
recipient lists for the outgoing e-mails and SMS messages,
as shown in FIGURE 5-4. To enable the use of e-mail and
SMS messaging services, at least one recipient list must be
defined for either service. You can define an unlimited
number of lists.
The Station PC verifies e-mail addresses and SMS numbers
in recipient lists and removes recipients from lists that have
non-existent addresses or numbers. If a recipient list for
5-4
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either service becomes empty, the Station PC displays an
error message.
Click the New list button to create a new recipient list. Click
the Remove list button to delete selected lists. For each
recipient list, click Add to specify individual recipient
information, or select a recipient and click Remove to delete
a recipient from a list.
Clicking the New list button while another recipient list is
selected results in a new copy of the selected list.

FIGURE 5-4 Recipient Lists
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Table 5-3 describes the Recipient Lists controls settings.

Setting
New List
Remove List
List name

Description
Enables the Current List area so that new recipient lists may
be named and specified.
Deletes the selected recipient list.
The name of the list of recipients. Make each list name
unique.

Recipient list

The e-mail addresses and SMS numbers specified for the current recipient list.

Add

Opens the Recipient dialog box to add new e-mail addresses
and SMS numbers to the current recipient list.

Edit

Opens the Recipient dialog box for the selected recipient so
that the e-mail address and SMS number may be edited.

Remove
Copy from
Name
E-mail Address
SMS Number

Deletes the selected recipient from the current list.
Copies all addresses from the selected recipient list under
Recipient Lists.
The name of the recipient.
The e-mail address of the recipient.
The mobile phone number of the recipient.
Table 5-3 Recipient List Control Settings

Messaging
The Messaging command is divided into two services:
SMTP (E-mail) and SMS (text messaging).
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SMTP (E-mail)
The SMTP (E-mail) Setup dialog box allows you to setup
E-mail message settings., as shown in Figure 5-5.

FIGURE 5-5 SMTP (E-mail) Setup
Table 5-4 describes the settings in the SMTP (E-mail)
Setup dialog box.

Setting

Description

SMTP mail server

The name of the SMTP mail server. Normally this address is
provided by the internet service provider.

Send Address

The e-mail address of the sender. If not specified correctly, the
SMTP may fail to send the message.

Use E-mail authentication

Select this option if the mail server requires authentication. If
selected, you must also enter the Login name and the Login
password.

Login name
Login password
SMTP port
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Login name for authentication.
Password required for authentication.
Port number to access the SMTP server. Normally it is 25. Do
not change this value unless required by the internet service
provider.

SMTP (E-mail)
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Setting

Description

Information request address

Send test e-mail

Your personal e-mail address. This information is appended to
the end of e-mail messages to simplify information requests
from customers.
Sends a test e-mail. Provide an address to send the test message. After sending, the Station PC displays the results and
content of the SMTP test.

Table 5-4 SMTP (E-mail) Settings

SMS (Text Messaging)
The SMS Setup dialog box allows you to setup the SMS
(text messaging) settings., as shown in Figure 5-6.
.

FIGURE 5-6 SMS (Text) Messaging Setup
Table 5-5 describes the settings in the SMS Setup dialog
box.

Setting
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Description

Mobile phone or modem port

The COM port where the mobile phone or modem is connected. Access is always through a COM port, even with integrated modems. The correct number may be found through the
Device Manager in Windows 7®.

Baud-rate

The desired communication speed between the Station PC and
the device.

SMS (Text Messaging)
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Setting

Description

Activation PIN

The PIN of your SIM card. Leave this field empty if the PIN
request is not activated or not needed for your SIM.

Send test SMS

Sends a test SMS, or text message. After sending, the Station
PC displays the results and content of the SMS test.
Table 5-5 SMS (Text Messaging) Settings

Graph
The Graph command is divided into three different dialog
boxes for setting up graphs used in reports. The graph setup
dialog boxes are as follows:
•

Time History Setup

•

Spectrogram Setup

•

Live Graph Setup

Time History Setup
The Time History Setup dialog box allows you to define up to four time history graphs, as shown in
Figure 5-7.

FIGURE 5-7 Time History Setup
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To set up graphs, specify the following options:
•

Background color

•

Axis color

•

Grid color

•

Header color

•

Font

•

Value trace color

•

Start value of the dB amplitude axis

•

Stop value of the dB amplitude axis

For each color or font option, click the corresponding
button, select the setting, and click OK. For other options,
click the setting from the drop-down lists.
For long time histories or those with Ldn and Lden values,
click the Additional Daily Settings button to launch the
Additional Daily Setup dialog box, as shown in Figure 5-8.

FIGURE 5-8 Additional Daily Setup
For each area--Day, Evening, and Night--you specify a
Start time from the 24-hour notation numbers listed in the
corresponding drop-down lists.
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For Penalty (dB), the number you specify is used in the Ldn
and Lden calculations.
The Color and Thickness options you specify in the
remaining areas are used for additional traces available in
long-term histories. The Hourly levels options begin with
four-hour histories and the others begin with one-day
histories.

Spectrogram Setup
The Spectrogram Setup dialog box allows you to specify
colors for a spectrogram in your reports, as shown in Figure
5-9.

FIGURE 5-9 Spectrogram Setup
For spectrograms, the color scale settings are marked by a
series of key points, where a particular sound level is
associated with a specific color. Colors between two key
points are calculated by interpolation. Initially, only two key
points are defined, but you may add other key points. The
key points are represented by markers at the bottom of the
color scale.
Table 5-6 describes how to edit the key points.
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Action

Description

Add a key point

Click a place on the key points bar.

Remove a key point

Select the key point and drag it outside the bar, or select a key
point and click on the Remove current color button.

Change the level of a key point

Select the key point and drag it with the mouse.

Change the color of a key point

Select the key point and click on the Current color button.

Table 5-6 Editing Keypoint Instructions
A color scale can be saved to, or loaded from, a selected
location using the Save scale and Load scale buttons,
respectively.

Live Graph Setup
The Live Graph Setup dialog box allows you to specify
parameters for an optional graph in the NoiseTutor
application window when operating in “Realtime Report”
working mode. The dialog box is shown in Figure 5-10.
To specify the parameters for the Live Graph, click the
buttons and select from the options, as performed in the
other graph setup dialog boxes.

FIGURE 5-10 Live Graph Setup
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Audio Recording
The audio recording options in NoiseTutor are enabled
through an authorized license file. This feature allows you to
continuously record signals applied to input connectors of
the Station PC audio board from supported instruments. The
recorded data is compressed dynamically into Vorbis format,
using much less disk space than uncompressed formats and
allowing for continuous recording for extended periods of
time.
Figure 5-11 shows the dialog box for specifying the settings
for audio recordings.

FIGURE 5-11 Audio Recording Setup
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Table 5-7 describes the settings for Audio Recording Setup
dialog box.

Setting

Description

Enable Audio Recording

Enables audio recording service.

Audio Device

Select the audio board to be used for service. If the list is
empty, no compatible audio boards have been found and the
service cannot be used.

Sampling Rate

Sampling rate of the input signal.

Channels

Select the number of channels to record.

Compression Quality

Audio compression quality. Select Highest, High, Medium,
Low, or Lowest. Each option also displays the approximate
disk space needed per hour.

Capture Mode

Select the capture mode Continuous, Daily, or Event. In
Continuous mode, everything is recorded. In Daily mode,
recordings begin and end on a daily basis according to blocks
of time specified by clicking the Add block... button. In
Event only mode, the audio signal is used only for the Event
Detection feature.

Create a new file every

Specify the length for recorded audio files in number of hours.
This setting is enabled in the Continuous mode only.

Daily time blocks

Click the Add block... button to specify daily time blocks for
recording each day. Once created, each time block appears in
the Daily time blocks list.

Automatic delete audio files

Deletes audio recording files older than the specified age.

Table 5-7 Audio Recording Settings
To specify the settings for the inputs of the audio board,
including volume, open the Windows 7® Control Panel,
click on Hardware and Sound > Sound and select the
settings. Alternately, you may be able to configure settings
through the audio board software.
The compressed audio data is saved in one of two subfolders within the Data folder. Continuous recordings are
saved in the Audio folder and the audio recorded during
events is saved in the AudioEvent folder.
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Audio Snapshot
By using the Audio Snapshot feature, you can take a
snapshot of an audio recording and send it via e-mail. This
feature requires an audio recording license file. To use the
feature, you must first enable audio recordings in the Audio
Recordings Setup dialog box, as shown in Figure 5-11.
Figure 5-12 shows the dialog box for specifying the settings
of audio snapshots.

FIGURE 5-12 Audio Snapshot Service Setup
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Table 5-8 describes the settings for Audio Snapshot Service
Setup dialog box.

Setting

Description

Enable Audio Snapshot
Recipients List

Enables audio snapshot service.
Select the recipient list for this e-mail service.

Subject

The subject of the e-mail message regarding the snapshot.

Message text

The message of the e-mail. For optimal results, make messages meaningful and avoid words that typically trigger antispam software.

Compression Quality

Audio compression quality. Select Highest, High, Medium,
Low, or Lowest.

Snapshot Length

The length, in minutes, of the audio snapshot. Select values
from 1 to 5 minutes.

Time History 1

Attaches the time history graph from Time History 1 setup in
Setup > Graph > Time History. Specify a pixel width and
height for the size of the graph.

Spectrogram

Attaches a spectrogram for the snapshot. Specify a pixel width
and height for the size of the graph.

Data File

Attaches the data file from the sound level meter to the message.

Include power status

Includes information about the power status of the Station PC
and the sound level meter in the message.

Table 5-8 Audio Snapshot Service Setup
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Event Detection
Event Detection is an optional command providing features
for detecting sound events and for sending notifications with
graphical presentations of the events. This option is enabled
through an authorized license file. With this feature, the
NoiseTutor Station analyzes time histories according to
specified values and thresholds, as shown in Figure 5-13.
You can also specify that the station send messages at the
end of events by e-mail, SMS (text), or that it load event
graphs and audio recordings to websites. The NoiseTutor
Station provides two functions for event detection so that
two events with differing thresholds can be analyzed and
reported in parallel.

FIGURE 5-13 Event Detection Setup
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Table 5-9 describes the settings in the Event Setup dialog
box.

Setting
Enable Event measurement
Use the Time Scheduler

Enables the Event Detection feature.
Enables Time Scheduler to be set according to specified days
of week and blocks of time. Click Edit Time Scheduler to
specify.

Value selection

The value to be measured for event detection.

Threshold Mode

The mode used for determining measurements that exceed
specified thresholds. Select Fixed Level to have the specified
value compared with the fixed threshold.Select Dynamic
Level to have the selected value compared with a dynamic
threshold that is measured against the last measured period of
time, plus a specified offset from reference.

Threshold

The value in dB to set as the threshold. Measurements exceeding this value are detected as events.

Reference value

5-18

Description

The value used to calculate the dynamic threshold.

Offset from reference

The offset value to be added to the dynamic calculated value
to form the actual threshold.

Reference time length

The length of time from which the dynamic value is calculated.

Pretrigger time

The specified period of time before the beginning of an event
that is included in the time history of the event. It may be helpful in reviewing differences in measurements just before the
event with measurements at the beginning of an event.

Minimum duration

The minimum time, in seconds, that constitutes an event. If
measurements fall and stay below specified thresholds before
the minimum duration time has elapsed, the event is canceled.
If the measurement rises again above the thresholds before the
specified minimum separation time, the event is restarted and
calculated from the first threshold trigger.

Maximum duration

The maximum time, in seconds, to store an event. If the duration of an event exceeds the specified maximum duration, the
time history is truncated to this value.

Minimum separation

The minimum time, in seconds, in which two events must be
separated to constitute separate events. If the amount of time
between two events is less than this value, the events are considered to be a single event.

Audio Snapshot
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Setting

Description

Posttrigger time

The specified period of time after the end of an event that is
included in the time history of the event. It may be helpful in
reviewing differences in measurements just after the event
with measurements at the end of an event.

Audio compression quality

The Vorbis audio format compression quality. This value is
ignored if the Enable Audio Recording option is selected in
the Audio Recording dialog box.

On event completion...

Enables notification or upload actions to execute upon completion of an event. The actions are sending e-mail, sending
SMS (text messages), and uploading graphs to websites. To
specify the settings for the actions, click the Setup button next
to the listed options.
Table 5-9 Event Setup Settings
The following sections describe the notification and upload
actions that can be executed upon event completion,
including:
•

Send E-mail

•

Send SMS (text messages)

•

Upload graphs to websites

Send E-mail
E-mail messages, sent upon event completion, contain
selected graphical representations of the event, including
time histories and spectrograms, as shown in Figure 5-14.

FIGURE 5-14 Event E-mail Setup
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Recordings may also be attached, if Audio Recording is
enabled in the Audio Recording Setup dialog box.
Table 5-10 describes the settings for Event E-mail Setup
dialog box.

Setting
Recipients list
Subject

Description
The name of the e-mail recipient list as configured with the
Recipient Lists command.
The subject of the message regarding the event.

E-mail text

The message of the e-mail. For optimal results, make messages meaningful and avoid words that typically trigger antispam software.

Time History 1

Attaches a time history graph for the event, as configured for
Time History 1 in the Graph > Time History Setup dialog
box. Specify a pixel width and height for the size of the graph.

Spectrogram
Audio recording

Attaches a spectrogram for the event. Specify a pixel width
and height for the size of the graph.
Attaches an audio recording of the event, if Audio Recording
is also enabled in the Audio Recording Setup dialog box.
Table 5-10 Event E-mail Settings

Send SMS (text messages)
SMS messages, sent upon event completion, contain only
the text in the message and the most common values that can
be calculated on the event. Only two settings are required for
SMS messaging: Recipient list and SMS text, as shown in
Table 5-14.

FIGURE 5-15 Event SMS Setup
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Upload Event Graphs and Audio to Websites
The NoiseTutor Station can upload graphs for the three most
recent events to Web 1 or Web 2. By using the recommended
wildcard in graph filenames (see dialog box below), you can
keep track which graphs correspond to which events. The
most recent event is always portrayed in a file with the
“1.jpg” ending. Upon completion of a new event, the least
recent graph is deleted and the next least recent graph is
renamed with a “3.jpg” ending. In this manner, new graphs
are cycled from numbers one through three, with the most
recent graph first, and the least recent graph third. Audio
filenames are also handled in the same manner, if specified
for upload. The Event SMS Setup dialog box is shown in
Figure 5-16.

FIGURE 5-16 Event Web Graph Setup
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Table 5-11 describes the settings for the Event Web Graph
dialog box.

Setting

Description

Time History

Includes the time history graph of Laeq in the image.

Spectrogram

Includes a spectrogram in the image.

Width/Height

The size of the bitmap in pixels.

Number of remembered events

The number of most recent events to be remembered for
graphical upload. Three is the maximum number of events.

Upload compressed audio record- Uploads the audio file to the website, if audio recording is
ing
enabled. The audio filename is the same as the graph filename,
but with the .ogg extension.
Filename

The destination filename for the graph. Use the wildcards
indicated in the dialog box for best results.
Table 5-11 Event Web Graph Settings

Reporting Modes
NoiseTutor provides two options for reporting: the Data File
mode and the Realtime Report mode.
The Data File mode downloads the data file from the
connected sound level meter and sends it by e-mail to a
recipient list or uploads it to an FTP site. This is the
principal mode. It is usually active as it handles the data
measured by the meter. It enables the user to automatically
receive data through e-mail or through an FTP server. The
NoiseTutor station keeps a copy of sent data on the local PC,
thereby making a backup copy of the data.
The Realtime Report working mode keeps a continuous
connection with the instrument, continuously reading the
current level measured by the meter. It produces a graphical
report that can be sent to a recipient list via e-mail or that can
be used for web publishing.
It is possible to use both modes simultaneously. In this case,
the Realtime Report mode is suspended during the data
download from the instrument, after which it is then
automatically restarted.
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Data File Settings
The Data File command launches dialog boxes for
delivering reports via e-mail or FTP in the Data File working
mode.

E-mail Setup
If you set up the NoiseTutor Station
to e-mail data files, the graphs in the
message are based on the data file. If
you want to view spectral data in the
message, you must enable logging
for spectral data on the sound level
meter. See the technical reference
manual for your sound level meter
for more information.

The E-mail 1... and the E-mail 2... options launch the Email Data File Service Setup dialog box.The settings are
shown in FIGURE 5-17.

FIGURE 5-17 E-mail Data File Service Setup
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Table 5-12 describes the settings for the E-mail Data File
Service Setup dialog box.

Setting

Description

Enable E-mail service
Recipients List
Subject

Enables/Disables e-mail service.
The recipient list for the e-mail service.
The subject of the message.

Message text

The text of the message. Type messages in such a way that
they are not filtered by anti-spam software.

Time History 1

Attaches a time history graph. On the right, specify the JPEG
size in pixels.

Spectrogram

Attaches a spectrogram. On the right, specify the bitmap size
in pixels.

Slmdl Data File
Include the PC power status

Attaches the downloaded file from the meter.
Includes information about the power supply status of the PC
and of the analyzer in the message text.

Table 5-12 E-mail Data File Service Settings

FTP Setup Service
The FTP1... and FTP2... options launch the FTP Service
Setup dialog box to setup the FTP upload service, as shown
in FIGURE 5-18.

FIGURE 5-18 “Data File” FTP Setup Window
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Table 5-13 describes the settings for the FTP Service Setup
dialog box.

Setting
Enable the FTP service
FTP Address

Description
Enables/Disables the FTP service.
The FTP server where the data files are uploaded. It is
possible to enter the address either in canonical form
(ftp.domain.x) or in numeric form (x.x.x.x).

User name

This is the user name to establish the FTP connection.

Password

This is the password to establish the FTP connection.

Folder name

The name of the sub-folder where the data file is copied. If left
empty, the files are copied to the root of the FTP site.
Table 5-13 FTP Service Settings

Realtime Report Settings
The Realtime Report command launches dialog boxes for
creating reports for delivery via e-mail or for publishing on a
website in the Realtime Report working mode.
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E-Mail Report
The Realtime Report > E-mail 1..., E-mail 2..., and E-mail
3... commands launch the E-mail Report Service Setup
dialog box. Three e-mail services are provided,
corresponding to the numbers in the command menu. The
settings are shown in FIGURE 5-19.

FIGURE 5-19 E-mail Report Service Setup
Table 5-14 describes the settings for the E-mail Report
Service Setup dialog box.

Setting
Enable E-mail Service
Recipients list
Subject
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Description
Enables/Disables the e-mail service.
The recipients list for the e-mail service.
The subject of the message.
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Setting

Description

Message text

The text of the message. Type messages in such a way that
they are not filtered by anti-spam software.

Send report every

Determines when the report message is sent.

Time History 1

Attaches a time history graph. On the right, specify the image
size in pixels.

Time History 2

Attaches a time history graph. On the right, specify the image
size in pixels.

Time History 3

Attaches a time history graph. On the right, specify the image
size in pixels.

Spectrogram

Attaches a spectrogram. On the right, specify the image size in
pixels.
Table 5-14 E-mail Report Service Settings

Daily, Weekly, or Monthly Monitoring
For longer monitoring periods, you can create daily, weekly,
or monthly monitoring reports. The Daily, Weekly,
Monthly... command launches the Daily Report Service
Setup dialog box, as shown in FIGURE 5-20.

FIGURE 5-20 Daily Report Service Setup
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Table 5-15 describes the settings for the Daily Report
Service Setup dialog box.

Setting

Description

Recipients list

The recipients list for the e-mail service.

Subject

The subject of the message.

Message text

The text of the message.

Send report every
Time History

Determines when the report message is sent.
Attaches a time history graph. On the right, for History, select
the value to be measured.

Spectrogram

Attaches a spectrogram.

Width/Height

The size of the image in pixels.

Additional data displayed

Percentiles table

Select additional options for displaying data, including
Hourly levels, Ldn, LN, Day/Evening/Night levels, and
Lden.
Select options to include percentile data displayed in tables:
Overall, Day/Night period, Continuous Night period,
Hourly, and Day,/Evening.Night.

Table 5-15 Daily Report Service Settings
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Web Publishing
By configuring your server with
default
values
with
the
Configuration Tool, as described in
the chapter Setting Up the
NoiseTutor Server, your graphs will
be linked to web pages and be
displayed within the pages. If you do
not configure your server and station
with default values, your IT
professional will need to provide
custom configurations to display
your graphs on web pages.

The Web1... or Web 2... option launches the Web Report
Service Setup box, as shown in FIGURE 5-21. The Web
Report Service creates a JPEG format image—with a graph
based on real-time data—and uploads it to the FTP site
associated with the web site. The graph is then published on
the web site.

FIGURE 5-21 Web Report Service Setup
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Table 5-16 describes the settings in the Web Report Service
Setup dialog box.

Setting

Description

Enable the Web Report Service
FTP Address

Enables/Disables Web Report service.
The FTP server where the data file must be uploaded. It is
possible to enter the address either in canonical form
(ftp.domain.x) or in numeric form (x.x.x.x).

User name

The user name to establish the FTP connection.

Password

The password to establish the FTP connection.

Folder name

The name of the sub folder where the data file is copied. If left
empty, the files are copied to the root of the FTP site.

New

Adds a new graph to the list.

Edit

Allows the selected graph on the list to be edited.

Remove
Import/Export

Removes the selected graph from the list.
Moves the web graph setup from one station to another.
Table 5-16 Web Publishing Settings
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Clicking the New button or Edit button on the Web Report
Service Setup box launches the Web Graph box, as shown
in FIGURE 5-22.
In the Web Graph dialog box, you can specify that a single
JPEG include a time history or a spectrogram, or both. Do
not change the file name. Wild cards are useful to
distinguish JPEG names based on the model and serial
number when the same website is publishing data from more
than one monitoring station.

FIGURE 5-22 Web Graph Setup
Table 5-17 describes the settings in the Web Graph dialog
box.

Setting
Time History
Sonogram
Time length
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Description
Includes a time history graph. On the right, specify one of the
four available templates to be used.
Includes a sonogram.
Determines the length of the time axis. The graphs display the
last captured data, independent of the length of the axis.

Web Publishing
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Setting

Description

Update every

Sets the update time interval. To keep the internet traffic manageable, select this value proportionally to the length of the
time axis.

Width/Height

Size of the JPEG in pixels.

Additional data displayed

Filename

Select additional options for displaying data, including
Hourly levels, Ldn, LN, Day/Evening/Night levels, and
Lden.
The destination file name.
Table 5-17 Web Graph Settings

System Administration Messages
The Administration Messages command provides options
for sending messages to the system administrator by e-mail
or by SMS (text messages).
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E-mail System Administration Messages
Selecting the Administration Messages > Email...
command launches the E-mail System Administration
Messages dialog box, as shown in Figure 5-23.

FIGURE 5-23 E-mail System Administration Messages
The recipient list for these messages should contain only the
address of the administrator(s) of the system. These
messages are sent for events that requires administrator
intervention. There are six events available:
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•

When the connection with the instrument is not possible
(or failed for any reason).

•

When the connection with the weather station is not
possible (or failed for any reason).

•

When the Windows® operating system is restarted
automatically by NoiseTutor (usually because of a
locked internet connection).

E-mail System Administration Messages
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•

When a temporary license is about to expire.

•

When a maintenance period has started.

•

When the power supply of the PC changes from AC to
battery, or vice-versa.

•

When the PC battery level drops below the specified
voltage

•

When the external battery level drops below the
specified voltage

•

When the door is opened or closed.

SMS System Administration Messages
Selecting the Administration Messages > SMS... command
launches the SMS System Administration Messages
dialog box, as shown in Figure 5-24.

FIGURE 5-24 SMS System Administration Messages
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The recipient list for these messages should contain only the
address of the administrator(s) of the system. These
messages are sent for events that requires administrator
intervention. There are six events available:
•

When the connection with the instrument is not possible
(or failed for any reason).

•

When the connection with the weather station is not
possible (or failed for any reason).

•

When the Windows® operating system is restarted
automatically by NoiseTutor (usually because of a
locked internet connection).

•

When a temporary license is about to expire.

•

When a maintenance period has started.

•

When the power supply of the PC changes from AC to
battery, or vice-versa.

•

When the PC battery level drops below the specified
voltage

•

When the external battery level drops below the
specified voltage

•

When the door is opened or closed.

•

When a website is not updated for more than the
specified number of minutes.

•

When the specified number of consecutive errors has
occurred for sending e-mail or performing FTP uploads.

Main commands
Use Start and Stop on the Commands menu to start and
stop the NoiseTutor Station operations. Clicking the Start
command begins the connection with the instrument, checks
if there is data to be downloaded, and begins the operations
for the enabled services.
To setup the NoiseTutor station so that it automatically
begins the Start command, refer to the section “Installing
the NoiseTutor Software” in the Installation and Setup
chapter of this manual. The automatic restart is effectively
executed with a delay of 30 seconds from the program run.
This delay is needed to allow the Windows® operating
system to complete loading.
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The Stop command ends the NoiseTutor Station operations
and disconnects the analyzer, but does not terminate the
sending of messages or the uploading of files. If the job
queue is not empty, this operation continues even after the
Stop command has been completed.
The Direct Screen command displays a window that
reproduces the screen of the meter itself, with buttons
positioned similar to those of the meter keyboard. Click
buttons to perform actions with the meter, similar to pressing
keys on the keypad of the meter. The instrument screen is
continuously displayed; thus it is possible to operate
remotely on the instrument, as if it were in your hands.
FIGURE 5-25 shows an example of the Direct Screen
window.

FIGURE 5-25 Direct Screen
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APPENDIX

A

Technical Specifications

The specifications contained in this chapter are subject to change without notice.

System Power Requirements
Battery Runtime (continuous,
streaming updates)

6.5 hours, from full charge, typical at
25C

Battery Runtime (daily updates)

30 hours, from full charge, typical at
25C

Charge Time

4 hours

AC Input

90-240V, 50-60 Hz

Battery Voltage

12.8V

Battery Type

Lithium Iron Phosphate

Battery Capacity

81.9 watt hours

Physical
Weight

16.0 lbs. (8.3 kg.)

Dimensions (W x L x H)

18 x 13 x 7 in. (46 x 33 x 18 cm.)

Environmental
Operating Temperature

- 40 to 140F (- 40 to 60 C)**

Humidity

0 to 99%, relative humidity, noncondensing

Enclosure

Rated IP66

**The temperatures indicated correspond to operation in direct sunlight. For operation at
higher environmental temperatures, the station must be shaded.

NoiseTutor System Manual

Technical Specifications

A-1

Station PC (provided)
Processor Speed

1.6 GHz

Memory

2 GB

Storage

80 GB

Operating System

Windows 7®

For specifications of 831 or SoundTrack LxT sound level meters, refer to the technical reference
manuals for those products.

Items not Included
•

Instrumentation Tripod (TRP003)

•

Website hosting items (PC, Microsoft IIS, and FTP)

•

SIM card for cell access

•

Software to administer the PC remotely, such as logmein, radmin, or teamviewer
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APPENDIX

B

Shipping Instructions

You may encounter some restrictions when shipping the NoiseTutor Station because it includes a
lithium ion battery. When shipping, follow these guidelines:
•

Make sure that the system is off prior to closing the case.

•

Do not place extra items in the case.

•

Label your shipping box with an IATA cautionary label, as shown in FIGURE B-1. Print the label
in color.

FIGURE B-1 IATA Caution Label
To comply with shipping regulations, you should, at a minimum, put the following warning and
provide your contact information on your package:
LITHIUM ION BATTERIES OR CELLS
This package contains Lithium Ion cells or batteries.
This package must be handled with care and not damaged.
In the event the battery or cell is damaged a flammability hazard exists.
If this package is damaged it must be quarantined, inspected and repackaged before shipment
continues.
NoiseTutor System Manual
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If the battery or cell itself is damaged the package must be repacked and returned to the shipper via
ground transport.
Damaged lithium batteries and cells are forbidden for transport by air in accordance with IATA
Special Provision A154.
Telephone number for additional information: Phone #_______________________
This language is in accordance with Reference Section II of Lithium Cell or Batteries Packing
Instruction-IATA Dangerous Goods Regulations.
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APPENDIX

C

Connecting Peripheral and
Power Devices

The instructions contained in this chapter show how to connect the NoiseTutor System to peripheral
devices or alternative sources of power.
Note: When ordering the optional ACC007 stopper used in the following procedures, specify the cable
being used to match the configuration.

Connecting PRM2103-FF Preamplifier
To connect the PRM2103-FF preamplifier, follow these steps:
Step 1

Identify or gather components, as shown:

Model 831
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CBL203-20

Cable Gland on NoiseTutor

PRM2103-FF

C-1

Step 2 Insert CBL203-20 through small gland in case so that the three-connector end (AUX, mic,
and power) is on the inside of the case.

AUX

Power

Mic

FIGURE C-2 Insert CBL203-20 through Small Gland
Step 3 Connect the other end of CBL203-20 to the PRM2103-FF.

FIGURE C-3 Connected PRM2103-FF
Step 4 Connect CBL203-20 AUX to Model 831.

C-2
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FIGURE C-4 Connected AUX
Step 5

Connect CBL203-20 Mic to Model 831.

FIGURE C-5 Connected Mic
Step 6

Connect CBL203-20 power to power source.
CBL203 power
connection

FIGURE C-6 Connected Power
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Step 7 Connect ground.

FIGURE C-7 Connected Ground
Step 8 Adjust cable length and tighten gland.

C-4
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FIGURE C-8 Adjusted CBL203-20

Connecting SEN031 or SEN032 Sensors
To connect the SEN031 or SEN032 sensors, follow these steps:
Step 1

Identify or gather components, as shown:

Model 831

SEN031 (shown)
or SEN032
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CBL167-20, with
Cable Gland and
ACC007 Stopper

DVX008A
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Step 2 Insert CBL167-20 through gland in case with ACC007 stopper so that the three-connector
end is on the inside of the case.

DVX008A

Power

Mic

FIGURE C-9 Insert CBL167-20 through Gland
Step 3 Connect the other end of CBL167-20 to SEN031 or SEN032 weather sensor.

FIGURE C-10 Connected Weather Sensor

C-6

NoiseTutor System Manual

Step 4

Connect CBL167-20 to DVX008A.

FIGURE C-11 CBL167-20 Connected to DVX008A
Step 5

Connect DVX008A to Model 831.

FIGURE C-12 Connected DVX008A
Step 6

Connect CBL167-20 to 12 VDC power (spare DC power plugs are included inside case)
Power connect
in case

FIGURE C-13 Connected Power
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Step 7 Follow the instructions in the weather station manual to locate the screw terminals on
SEN031 or SEN032 and insert jumpers as follows:
• HTG- to VIN• HTG+ to VIN+

Jumpers

FIGURE C-14 Wire Jumpers
Step 8 Adjust cable length and tighten gland.

FIGURE C-15 Adjusted CBL167-20
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Step 9

Setup SEN032 or SEN031 heater control in the Model 831, as follows

®

FIGURE C-16 Heater Setup

Vaisala is a registered trademark of Vaisala Corporation.

•

Enabled (shown above): the heater turns on or off automatically depending on the ambient
temperature.The Start Time and End Time are dimmed.

•

Timer: Makes the Start Time and End Time available for turning the heater on or off,
respectively. Times are shown in 24-hour notation.

•

Off: Keeps the heater always off. The Start Time and End Time are dimmed.

For more information on heater and weather settings, see the Model 831 and SEN031 or SEN032
manuals.

Connecting to Alternative 12 VDC Power (e.g. Solar)
To connect to alternative 12 VDC, follow these steps:
Step 1

Identify or gather components, as shown:
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Model 831 and
NoiseTutor Software

CBL204-10

Cable Gland with
ACC007 Stopper

Alternative
12 VDC
Power
Source

Step 2 Insert CBL204-10 through gland in case with ACC007 stopper, as shown in Step 1.

C-10

NoiseTutor System Manual

Step 3

Disconnect NoiseTutor internal battery.

Disconnect

FIGURE C-17 Disconnect Battery Cable
Step 4

Connect CBL204-10 to available power connector in NoiseTutor.

Connected to
CBL204-10
Disconnected
battery cable

FIGURE C-18 CBL204-10 Connected to NoiseTutor
Step 5

Connect CBL204-10 to battery or other 12V power supply.
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Step 6 Adjust cable length and tighten gland.

FIGURE C-19 Adjusted CBL204-10
Step 7 Turn on the Model 831 and press the 3 (TOOLS) key and then select System Proper-

ties. Select the Power tab and set External Shutoff Voltage. For 12 V SLA batteries, set 10.8 V. For Lithium Iron Phosphate batteries, set 12.0 V.

FIGURE C-20 Shutoff Voltage on Model 831
The PC requires connection to the Model 831 and LS300 modem, therefore it must shutdown prior to
the Model 831 and LS300 shutting down. This is why the NoiseTutor shutdown voltage is higher than
the Model 831.
Battery Type

NoiseTutor

Model 831

LS300

Internal Green K2 12.8 V
LiFePO3

12.4 V

12.0 V

120 (0.1 V)a

External 12 V Lead Acid

11.0 V

10.8 V

108 (0.1 V)

Table C-1 Shutdown Voltage Values
a. LS300 requires the shutdown voltage to be entered in values of 1/10 volt, see FIGURE C-22
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Step 8

Open NoiseTutor software on the PC and click Setup > System. On the System Setup dialog box, specify the low-voltage threshold for shutting down the PC. Refer to Table C-1 for
value.

FIGURE C-21 Shutoff Voltage for PC
Step 9

Open the ACEmanager web page for the LS300, navigate Services > Low Power. Specify
the low-voltage threshold for shutting down the LS300. Refer to Table C-1 for value.

FIGURE C-22 Shutoff Voltage for LS300
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Connecting to GPS001
To connect to alternative 12 VDC, follow these steps:
Step 1 Connect GPS001 USB to Model 831 USB-A input.
Step 2 Position GPS001 on top of unit for best reception.

GPS001
FIGURE C-23 GPS001 Position
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